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1. AxMath Installation 

To install AxMath, exit AxMath, MS Word and PowerPoint, then run the AxMath setup 
program and follow the instructions in the dialogs. 

The first version of AxMath was released at the end of 2014, and the antivirus software may 
be sensitive to a new software. The installation package downloaded from our official website 
(http://www.amyxun.com) is guaranteed being secure. To ensure security, you can use antivirus 
software to scan the installation package before installation.  

The installation and running of AxMath requires to read and write the system’s registry, if the 
antivirus software alarm for that reason, please select “Allow all operations” or a option like that. 

If at any time you need to uninstall AxMath, simply click on the Uninstall icon located in the 
AxMath program directory. The uninstalling also need to exit AxMath, MS Word and PowerPoint. 

System Requirements : Windows 7 and newer, including Windows 10.  

http://www.amyxun.com/
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2. Introduction 

AxMath’s main interface can be set to “workspace + toolbox panel + right sidebar” mode or 
“workspace + LaTeX editor + right sidebar” mode. The right sidebar provides memo-board, tile-wall 
and equation library, it can be turned on or off as required. 

 

Fig.2.1 Mode 1: workspace + toolbox panel + right sidebar 

 

Fig.2.2 Mode 2: workspace + LaTeX editor + right sidebar 
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Editing & Typesetting  

 

What you see is what you get 

Graphical typesetting 

A scrollable and customizable toolbox panel is applied to present all symbols and expression-building structures. 

Hotkey input and interacitve LaTeX input are both supported. 

LaTeX editor with syntax highlighting is povieded. 

AutoComplete Suggestions for LaTeX. 

Versatile assistants and gadgets on the right sidebar to improve working efficiency. 

The equations’ appearance conform to the AMS/LaTeX standard 

User defined symbols 

Matrix templates, auto-filling and partitioning for matrices 

Searching and replacing 

Colorful equations, automatically or manully 

MS-Office plug-in for equation numbering and management 

 

 

Sientific calculating function  

 

Calculating based on equation 

Variable and constant definition 

 

 

Equation output and compatibility  

 

AxMath is an OLE server. It works as a plug-in with word processors such as MS-WORD 

The baseline of the surrounding text is aligned with the AxMath equation’s baseline for many word processors 

Vector output, can be used directly for printing or publishing 

Can be exported to BMP, JPG, PNG, GIF and other common picture formats 

Picture capture is supported 
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3. Editing  

3.1 Basic Operations 

3.1.1 WYSIWYG 

WYSIWYG, means what you see is what you get, is the basic way to editing equations in 
AxMath. In the workspace of AxMath, you can edit equations just like editing text using a common 
text editor. You can insert special mathmatic symbols or expression-building structures by clicking 
on buttons of the toolbox panel, or by pressing hotkeys, or by typing in LaTeX language. 

A two-dimensional caret, as shown in Fig.2.1, blinks in the AxMath’s workspace to indicate the 
current edit position. You can use the mouse click and Home key, End key, and the four direction 
keys to change the edit position. 

3.1.2 Active Font Style 

Check status of the buttons ( 
 
) decides the active font style, which may be regular, 

italic, bold or bold-italic. You can check them on/off by pressing the button or the hotkeys Ctrl+B 
and Ctrl+I respectively. 

3.1.3 Change Font Style 

If you want to change the font style of a segment of the existing text, select them firstly, then 
popup the right-click menu and select the corresponding command, or click on one of the toolbar 

buttons ( 
 
), or press the hotkeys Ctrl+1~4. 

3.1.4 Change the Workspace View with the Mouse Wheel 

When the mouse cursor is inside the workspace area, you can scroll the view vertically by 
rolling the mouse wheel, or scroll the view horzontally by rolling the mouse wheel with the Shift 
key pressed, or zoom the view by rolling the mouse wheel with the Ctrl key pressed. 

3.2 Toolbox Panel 

In this document, all elements for building equations are divided into two classes: a) symbols 
that represent variables, matrices or vectors, function names, numbers, operators, labels, etc.; and 
b) expression-building structures that are subdivided into general Layout, script and limit, tabular 
math and elementary math schemata, etc. A expression-building structure typically has one or 
more sub fields as nests for child elements. 

AxMath adopts a kind of scrollable toolbox panel to present all these symbols and 
expression-building structures, as shown in Fig.2.1. Any particular piece of equation can be built 
out of them. 

3.2.1 Palettes & Buttons 

All symbols and expression-building structures are categorized into 11 palettes. You can click 
on the category tab to select which one to be the current palette. When the mouse cursor is 
located inside the panel area, you can also change the current palette by rolling the mouse wheel.  

When you click on a button of the panel, the corresponding mathematic symbol or 
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expression-building structure will be created at the caret position. You can also place a symbol or a 
expression-building structure to a desired position directly by drag-drop operation.  

You can change the order of the palettes by using the right-click menu on the category tab. 

3.2.2 Change the Appearance and Background Color 

The appearance of the toolbox panel is customizable. To open the setting dialog, right-click on 
any one button of the panel and select “Appearance…” in the context menu. You can enable the 
check “Using Large Icons” in the dialog if you think the icons on the UI are too small. 

You can also set a distinctive background color for each palette using the entry “Set Page 
Color” which can be found int the same context menu. 

3.2.3 Re-mapping and Expanding 

Some palettes of the toolbox panel, such as the category of binary operators, contain a large 
number of symbols and expression-building structures. To keep the interface clean and tidy, 
AxMath makes them collapsed. Only a part of symbols and expression-building structures, maybe 
the most commonly used, are pinned on the front interface. You can fetch all symbols by the tail 

button ( 
 
). And you are also allowed to re-mapping the buttons of the collapsed pages. The 

re-mapping command can be found in the context menu.  

3.3 Hotkeys 

3.3.1 Define a Hotkey 

Hotkeys, or keyboard accelerators, allow the users to input those special mathmatic symbols 
or expression-building structures, that cannot be typped directly by keyboard, without clicking on 
the toolbox panel. You can assign a hotkey for any button of the toolbox panel. Right-click on any 
one button of the panel to popup the context menu, then select the entry “Set Hotkey” to open 
the dialog for setting the hotkey. 

Generally, a hotkey is made up of a primary key and a secondary key. The secondary key can 
be Ctrl, Alt, Ctrl+Shift, Alt+Shift or Ctrl+Alt+Shift. The primary key can be a character, a number, a 
punctuation or a direction key. The primary key is not case-sensitive. 

Note: Some hotkeys are system reserved and should not be defined as custom hotkeys. For 
example, “Ctrl+C” is regularly to mean “copy”. See section 3.3.2 for more details about system 
reserved hotkeys. 

If you forget which hotkey has been assigned to a button, just right-click on the button, the 
hotkey definition will be shown in the context menu. You can also review all user-defined hotkeys 
in the “TeX Language & Hotkeys” tab of the “AxMath Settings” dialog which can be opened by 

clicking on the toolbar button ( 
 
). 
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3.3.2 Default Hotkeys 
 

Key Definition Function System Reserved 

   ESC Erase Highlights of Search Results Yes 

   F1 Help Yes 

   F2 Save Yes 

   F3 String Find and Replace Yes 

Ctrl   F3 Find the Similar Segment Yes 

   F4 User Symbols Yes 

   F5 Re-calculate the Current Line Yes 

   F6 Re-calculate All Lines Yes 

   F7 Open the Right Sidebar Yes 

   Home Move the Edit Position to the Line Head Yes 

   End Move the Edit Position to the Line Tail Yes 

Ctrl   Enter Save and Exit for OLE Server Mode Yes 

Ctrl   1 Modify Font Style of the Selected Text to Be Regular Yes 

Ctrl   2 Modify Font Style of the Selected Text to Be Italic Yes 

Ctrl   3 Modify Font Style of the Selected Text to Be Bold Yes 

Ctrl   4 Modify Font Style of the Selected Text to Be Bold-italic Yes 

Ctrl   A Select All Yes 

Ctrl   B Font Bold Yes 

Ctrl   C/X/V Copy / Cut / Paste Yes 

Ctrl   G Temporarily Switch to Greek Keyboard Yes 

Ctrl   I Font Italic Yes 

Ctrl   N/S New / Save Yes 

Ctrl   T Copy Text Yes 

Ctrl   Y/Z Redo / Undo Yes 

Ctrl   Tab Switch Edit Mode Yes 

Ctrl   Home Move Edit Position to the Document Head Yes 

Ctrl   End Move Edit Position to the Document Tail Yes 

 Shift  Enter Convert the Code in the LaTeX Editor to Equation Yes 

  Alt C Set the Color of the Selected Yes 

  Alt Up Insert a Row above the Edit Position, for Matrices Yes 

  Alt Down Insert a Row below the Edit Position, for Matrices Yes 

  Alt Left Insert a Column before the Edit Position, for Matrices Yes 

  Alt Right Insert a Column after the Edit Position, for Matrices Yes 

Ctrl  Alt Up Delete the Row above the Edit Position, for Matrices Yes 

Ctrl  Alt Down Delete the Row below the Edit Position, for Matrices Yes 

Ctrl  Alt Left Delete the Column before the Edit Position, for Matrices Yes 

Ctrl  Alt Right Delete the Column after the Edit Position, for Matrices Yes 

Ctrl   D ◦  

Ctrl   F   

Ctrl   H   

Ctrl   J   

Ctrl   L   

Ctrl   P   

Ctrl   R   

Ctrl Shift  I   

Ctrl Shift  P   

Ctrl Shift  S   
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3.4 Typing Greek Characters 

Greek characters are very common in technical and scientific equations. Besides clicking on 
the toolbox panel, AxMath offers more ways to input Greek characters. 

1. Switching the keyboard to the Greek mode temporarily by pressing “Ctrl+G”. Here the 
word “temporarily” means that after entering one Greek character, the keyboard will 
automatically restore to the original mode. Fig.3.1 shows the Greek keyboard layout. For 
example, press “Ctrl+G”, “d” and “e” in turn, and you will get “ ”.  

2. Using the interactive LaTeX language, e.g. input “\alpha”, and you will get “ ” after 

pressing the Enter key. See section 3.5 for more details about LaTeX. 

 

Q  W E R T Y U I O P 
Θ θ Ω ω E ε R ρ T τ Ψ ψ U υ  I ι O ο Π π 

 

A  S D F G H J K L 
A α Σ σ Δ δ Φ ϕ Γ γ Η η Θ φ Κ κ Λ λ 

 

Z  X C V B N M 
Ζ ζ Ξ ξ C χ ς ϖ B β  N ν M μ 

Fig.3.1 Greek Keyboard 

 

3.5 LaTeX Language Support 

TeX is a typesetting language invented in the late 1970's by Donald Knuth, a computer science 
professor of Stanford University. It is a powerful document processor, especially for documents 
containing equations. TeX is widely used for the production of technical and scientific 
documentation because of its exquisite effect in publishing, and also used by many web 
applications for equation prenstations because it is easy to type in web forms. There are several 
branched versions of TeX, LaTeX, or AMS-LaTeX, being one of the most popular. Please visit 
http://www.ams.org/publications/authors/tex/amslatex for more information on AMS-LaTeX. 

AxMath’s translator is mainly based on AMS-LaTeX, but it is not very strict on syntax as other 
applications. Some commands originated from other branchs, such as Mathjax, are also valid in 
AxMath. It is notable that AxMath is designed for processing equations, LaTeX commands those 
are not commonly used in math equations may be unrecognizable in AxMath. 

The following is an example of LaTeX language for quadratic formula: 

$$ \frac{-b\pm \sqrt{b^2-4ac}}{2a} $$ 

And the corresponding equation would appear in AxMath’s workspace: 

 

There are several ways, including interactive LaTeX input, clipboard and a specially designed 
LaTeX editor, for equation conversion to and from LaTeX code.  

http://www.ams.org/publications/authors/tex/amslatex
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3.5.1 LaTeX Editor 

AxMath provides a LaTeX script editor. You can press the toolbar button (  ) or the 

hotkey “Ctrl+Tab” to open the editor. In the editor, as shown in Fig.2.2. it is convenient to input 
LaTeX code with the assist of syntax hightlighting, AutoComplete Suggestions. 

You can press the toolbar button ( 
 
) or the hotkey “Shift+Enter” to convert the code 

to equations, or, conversely, press the toolbar button ( 
 
) to restore the equations to LaTeX 

code. 

The editor allows you to set font and syntax highlighting scheme. You can right-click anywhere 
inside the editor, then select the command “Text Editor Settings” in the context menu to open the 
settings dialog. You can also find the entry in the “TeX Language & Hotkeys” tab of the “AxMath 

Settings” dialog which can be opened by clicking on the toolbar button ( 
 
). 

3.5.2 Interactive LaTeX Input 

You can edit equations by typing in LaTeX language directly in the workspace, as shown in 
Fig.3.2. The string after the first “ \ ”, “ ^ ” or “ _ ” will be rendered in blue color, means that it is 
assumed to be a piece of LaTeX code. After pressing Enter key, the string will be replaced by the 
conversion result. 

You can turn on/off the interactive LaTeX language in the “TeX Language & Hotkeys” tab of 

the “AxMath Settings” dialog which can be opened by clicking on the toolbar button ( 
 
). 

 

 

 

  

Fig.3.2 Edit Equations with interactive LaTeX language 

3.5.3 AutoComplete Suggestions 

AutoComplete Suggestions make it easier to type equations in TeX language. In AxMath, when 
you type a “ \ ”, indicating that you will input some LaTeX code in the following, a prompt bar will 
pop up. AxMath suggests candidates according to the string nearby the caret and dialplays them in 
the prompt bar, as shown in Fig.3.3. You can select a candidate by pressing Space key, numeric keys 
or mouse clicking to complete the LaTeX code automatically. If you do not intend to select a 
candidate from the prompt bar, just press Enter key to ignore it, or press ESC key to close the 
prompt bar. Users can use the arrow keys, the PgUp/PgDn keys, and the comma/dot keys to turn 
the page of the prompt bar.  

If you do not need this feature, you can turn it off in the “TeX Language & Hotkeys” tab of the 

“AxMath Settings” dialog which can be opened by clicking on the toolbar button ( 
 
). 
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Fig.3.3 AutoComplete Suggestions for LaTeX 

3.6 Assistants 

3.6.1 Recognize and Auto-Correct 

In AxMath, you can format text with 4 font styles, i.e. regular, italic, bold and bold-italic. Italic 
is the default font style in AxMath and the most frequently used one, since a italic character 
usually represents a variable.  

AxMath presents several ways to set font style. In addition to the basic ways described in 
section 3.1.2 and 3.1.3. You can pre-define expressions and assign a special font style for each of 
them. In editing process, AxMath will recognize the expressions and format them with the 
pre-defined font style automatically. For example, if you have pre-defined “sin” with regular font 
style, once you input the expression “sin”, the font style of the “sin” will be formatted with regular 
font style automatically, regardless what the active font style is.  

To add new pre-defined expressions, use the context menu in the “Assistants” tab of the 

“AxMath Settings” dialog, which can be opened by clicking on the toolbar button ( 
 
). Some 

common expressions has been collected in AxMath, you can load them using the context menu. 

3.6.2 Other Assistants 

AxMath also provides assistants to auto-correct the font style of Chinese characters, numbers 
and punctuations, and to display separator lines in workspace, etc. For more details about AxMath 
assistants, explore the “Assistants” tab of the “AxMath Settings” dialog which can be opened by 

clicking on the toolbar button ( 
 
). All of these assistants can be turned off if you want. 

3.7 Clipboard and Drag-drop 

3.7.1 Copy the OLE Data Object 

A cutting (Ctrl+X) or a copying (Ctrl+C) operation conducted in the workspace will set the 
clipboard with a OLE data object. The object contains all information of the equation. This format 
can be used to exchange data between AxMath processes, and can also be pasted directly into OLE 
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object containers (such as MS-WORD). 

3.7.2 Copy Text 

You can cut or copy text from the LaTeX editor in a regular way.  

To copy LaTeX code from the workspace, select all or a piece of equation, then right-click and 
select the entry "copy text" from the context menu. This is convenient for those who frequently 
need insert equations, represented by LaTeX code, to a TeX script document. The hotkey for this 
operation is Ctrl+T. 

3.7.3 Paste 

When a paste (Ctrl+V) command is trigged in the workspace, AxMath will do a format check 
and a conversion, if necessary, before pasting data to the caret position. If the clipboard contains 
the OLE data object, The pasting will continue normally. Else if the clipboard contains text, AxMath 
will try to convert it in LaTeX syntax. If the conversion succeeded, the coversion results will be 
pasted to the caret position. Otherwise, the plain text will be pasted. 

3.7.4 Drag-drop 

Drag-and-drop operations typically involve two parties: a drag source from which the dragged 
object originates and a drop target which receives the dropped object. In AxMath, the workspace 
and the right sidebar can act as both the drag source and the drop target, while the symbol panel 
can only be the drag source. 

AxMath supports several drag-drop operations as the following list: 

1. Drag from the toolbox panels to the workspace. 

2. Drag from the right sidebar (the memo-board, the tile-wall and the equation library) to the 
workspace. 

3. Drag from the workspace to the right sidebar, i.e, to create a new item for the 
memo-board, the tile-wall or the equation library. If the Ctrl key is pressed during the 
process, the content of the drop target will be replaced by that of the drag source, instead 
of to create. 

4. Drag and drop inside the workspace, i.e, to move the selected part from one position to 
another. If the Ctrl key is pressed during the process. The selected part will be duplicated 
to the target location, instead of being moved. 

5. Drag and drop inside the memo-board, the tile-wall or the equation library, i.e, to move a 
item from one position to another. 

6. Drag from AxMath, including workspace and the right side panel, to a MS-Word document 
or other OLE containers, or vice verse. 

3.8 Gadgets on the Right Sidebar 

The right sidebar of AxMath is consist of the memo-board, the tile-wall and the equation 
library. The three gadgets basically work on the same principle. However, there are differences in 
the mode of operation. Each one of them is fundamental to make up the whole versatile toolkit on 
the right sidebar. The toolkit helps to greatly improve your work efficiency. 

The right sidebar can be shown or hiden by clicking ton the toolbar button (  ) or by 
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pressing the hotkey “F7”. The three gadgets share the same display space of the right sidebar. Click 

on one button of the right toolbar ( 
 
) to choose which one to be shown. 

3.8.1 The Memo-board 

The memo-board of AxMath works like a multi-frame clipboard. Every time you do a cutting 
or copying operation, the memo-board creates a new item from the clipboard data, and insert it to 
the list in reverse chronological order. You can also create a new item for the memo-board by 
drag-drop from the workspace, as mentioned in section 3.7.4. 

The contents of the items in the memo-board can be pasted to the workspace by drag-drop or 
double click. You can export the tile-wall to a file and reload it when necessary. 

The size of the memo-board (maximum number of items) can be customized. You can also 
make the memo-board to record input history. These options can be found in the “Advanced” tab 

of the “AxMath Settings” dialog which can be opened by clicking on the toolbar button ( 
 
). 

3.8.2 The Tile-wall 

The tile-wall of AxMath is designed to store some equation segments which are short but 
repetitively used. In contrast to the memo-board and the equation library, the tile-wall arranges 
items more compactly, and supports hotkey and TeX macro definition. 

To create, move or update a tile item, please refer to section 3.7.4. You can export the 
tile-wall to a file and reload it when necessary, as well as the memo-board. 

You can set a distinctive color for each one tile, and make simple classifications by adding 
labels among the tiles. All these entries can be found in the context menu. As you can see, context 
menus are employed almost everywhere in AxMath. Whenever you want to do something but can 
not find the toolbox or button, try right-clicking. 

3.8.3 The Equation Library 

AxMath provides a large mount of equations for your reference. They are catalogued and 
detailed classified in the equation library. Here you can browse equations, search a equation by 
keywords and learn about the relevant of the equations, and certainly, insert them to the 
workspace as you need. 

The equation library applies a tree list to make it easier to retrieve equation items, as shown 

in Fig.3.4.A. You can click on the button (  ) to open the tree list. In the tree list, each root 

node acts as a book case, each leaf node links to a book page, and each middle node may be a 
book, a chapter or a section, depend on its level in the tree list.  

You can open the equation search engine by the button (  ). Keywords for the search 

engine can be “Newton”, “Euler” or “Common-used integral”, “Ordinary differential equation” and 
so on. 
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A. The Tree List                                      B. Book Page 

Fig.3.4 The Equation Library 

AxMath also presents a favorite list (  ) and a recent list (  ) to help you fetch your 

most frequently-used book pages fast. Right-click on a book page, as shown in Fig.3.4.B., you can 
find the entry “Favorite” in the context menu. 

The tree list works just like the Windows Explorer. All edit commands for the tree list can be 

found in the context menu, and the toolbar (  ) provides some commonly-used 

functions. 

You can use the drag-drop method that described in section 3.7.4. to create, move or update 
an item in book pages. Futhermore, you can open the “Entry Title, KeyWords and Figure” dialog 
by the context menu and edit the title, the keywords and the figure of an item.  

Note: Every time you re-install AxMath, the equation library will be reset. So you may need to 
backup the equation library before re-installing a new version of AxMath. 
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3.9 Find and Replace 

3.9.1 String Search and Replace 

To open the “String Search and Replace” dialog, right-click on the workspace, and then select 
the command in the context menu, or press the hotkey "Ctrl+F3”. 

You can format the replacement with a special font style. That is useful since there are usually 
strict requirement on font style of the symbols in science equations.  

3.9.2 Find the Similar Segments 

You can search all the same segments as the selected in the workspace by the “Find the 
Similar Segments” command in the context menu, or pressing the hotkey “F3”. This function can 
be used to search any type of symbol and expression-building structure, while the “String Search” 
method mentioned in section 3.9.1 can only used for normal strings. 

3.9.3 A Flexible Replacement Method to all Find Results 

You can replace all find results with the selected segment in the workspace, an item from the 
gadgets of the right sidebar, or a basic element of the toolbox panel. The corresponding command 
entry is available in their context menu. The tutorial E-05, in chapter 9, illustrates how it works. 

3.9.4 Erase Find Results Highlight 

All the find results will be highlighted with lightgreen background color. You can erase the 
highlight using the context menu or just by pressing ESC key. 

3.10 Matrix 

3.10.1 Create a Matrix 

When you click on one of the buttons inside the red-edge rectangle as shown in Fig.3.5.A, the 
dialog for laying out matrices is opened. Here you can decide the matrix’s dimension, make 
partition and set typeset options. AxMath also provides a matrix template picker and an auto-fill 
tool to facilitate the subsequent work after the creation, since a matrix usually has a series of 
repetitive elements with incremental subscripts.  

If you want to create a blank matrix of fixed dimension without opening the matrix building 
dialog, click on one of the buttons above the red-edge rectangle, as shown in Fig.3.5.A. 

Eight special-typset matrix templates are provided on the right side of the matrix palette. 
They are usually used in an expression of piecewise function, or an expression that is too long to 
be aligned in one line. Some of them is mentioned in the tutorial chapter. 
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Fig.3.5 Tools for Matrix Creation 

 

3.10.2 Modify a Matrix 

You should select the matrix before modifying it. Then right-click inside the workspace to pop 
up the context menu, and you will find a series of submenus, that can be used to modify the 
matrix’s typset, follows the entry “Modify the Matrix’s Typeset”, as shown in Fig.3.6. 

When you right-click on an element of a matrix as you wish, the submenus of “Change the 
Matrix’s Dimension” will pop up. You can also using hotkeys (see section 3.3.2 for more details) to 
change the dimension when the caret is inside the matrix. 
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Fig.3.6 Modify a Matrix’s Typeset 

3.11 User-defined Symbols 

You can click on the button ( 
 
) of the palette (  ), or press the hotkey F4, to 

open the user-defined symbol panel. Then click on the button "New..." to open the symbol editor 
and create a new user-defined symbol. 

User-defined symbols are built on existing glyphs. So the first thing to create a new symbol is 

importing a glyph from the font library. Press the button (  ) to do that. 

In the symbol editor, you can do minor modifications, such as clipping, scaling, tilting, fliping 
and so on, while major modifications such as moving knots of the graphic path are not allowed. So 
selecting a proper font is the most important thing to create the symbol you wished. 

Note: The user-defined symbols are saved as a file in the “AppData” folder of the Windows 
system partition. The file may be lost when you update or reinstall the OS, you should backup the 
symbols when necessary. 
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4. Typesetting 

4.1 Font and Style 

AxMath basicly renders equations on the standards of AMS-LaTeX. AMS-LaTeX has involved a 
well-designed scheme on the font and style, but there are still different requirements on that. 

A graphical designer is employed for individual preference of the font and style, as shown in 
Fig.4.1. It can be opened in the “Font & Style” tab of the “AxMath Settings” dialog, which can be 

opened by clicking on the toolbar button ( 
 
). Here you can modify the current scheme by 

checking buttons, selecting in lists or typing in edit boxes. The meaning of each control is 
illustrated by the surrounding picture, or text, if necessary. 

Note: For the edit boxes representing a size value, positive numbers are required, while for 
those who representing a position value, all numbers are permitted. The unit for font size number 
is points (1 point = 1/72 inch), and, a trailing "%" represents a percent of the font size. 

 

Fig.4.1 The Graphical Designer for Equation Font and Style 

4.2 Equation Color 

AxMath equations can be automatically colored or manually colored. You can click on the 
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toolbar button (  ) to toggle.  

In the manually coloring mode, you can select a segment of the equation, then click on the 

toolbar button (  ) to open the color dialog from where you will pick a color for the segment 

of equaion. You can also find the command entry in the context menu from the work space. The 
hotkey is Alt+C. Another way to color the selected segment is using the hotkey group Alt+1…9. 
Each hotkey of the group corresponds a color.  

In the automatically coloring mode, all symbols and compsite structures in the equation are 
colored automatically according to the color scheme  

The hotkey colors and the color scheme for automatically mode can be customized in the 
"Color" tab of the “AxMath Setting” dialog. 

4.3 Scheme 

A scheme of AxMath means a group of all settings for font, style and colors which is stored as 
a file. The AxMath settings dialog presents a button named “Scheme…” at the bottom side, as 
shown in Fig.4.1. Press on the button to pop up the context menu that allow you to save or reload 
schemes. There are 3 built-in schemes that are frequently-used and easy find. 

1. Default scheme 

The group of factory settings. It can not be over-write. 

2. The active scheme 

A new equation is always formatted by the active scheme. It is copied from default scheme at 
the first time you start AxMath, and everytime when you change the font, style or colors, the 
active scheme will be refreshed with the new settings if you have checked on the option “Use for 
new cases”, which can be found at the bottom of the settings dialog. 

3. My favorite scheme 

This scheme is used for storing your preference settings. You can overwrite it in AxMath using 
the context menu mentioned above. 

The built in themes can also be cited in MS-WORD, please see chatper 6 to learn more 
information about that. 

4.4 Alignment 

4.4.1 Alignment with the Surrounding Text 

In general, AxMath equation objects that are inserted in an OLE container programs are 
aligned at bottom with the surrounding text, as shown in the first row of Fig.4.2. But in containers 
that support baseline alignment, such as MS-WORD and WPS, the equations are aligned at the 
baseline with their surrounding text by default, as shown in the second row of Fig.4.2. If you want 
to align an equation at the bottom line with the surrounding text in MS-WORD, select the equation, 
click the WORD toolbar button “clearing format (  )” in the Home tab. 
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Fig.4.2 Alignment with the Surrounding Text 

You can align a multi-line equation at the whole center or at the baseline of the last line of it 
with the surrounding text. The check button is located in the “Advanced” tab of the “AxMath 

Settings” dialog, which can be opened by clicking on the toolbar button ( 
 
). 

4.4.2 Vertical Alignment 

Using the button group (  ), you can set a multi-line equation to align 

vertically at left, at center, at right or at the first = (equal sign) of each line. Equal sign alignment 
can achieve the following typesetting result: 

 

4.4.3 Column Alignment inside a Matrix 

Choose either Left, Center, Right, At = (equal sign), or At . (decimal point) to align all the 
matrix elements in all columns. You can find the options in the laying out dialog when create a new 
matrix or in the context menu when modifying an exist matrix by right click, as mentioned in 
section 3.10. A matrix with alignment at decimal point looks like: 

  

4.5 Phantom Elements 

Phantom techonolgy is occasionally appied for some special purpose. On AxMath’s toolbox 
panel, there are 4 buttons for phantom, as shown in Fig.4.3.A, inside the red-edge rectangle. The 
functions of them is illustrated in Fig.4.3.B. 
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A 

Button LaTeX Code Function/Effect 

 
- Restore the selected phantom elements to original(cancel phantom) 

 
\phantom{…} Create a phantom element with the same width and the same height 

 
\hphantom{…} Create a phantom element with the same width and zero height 

 
\vphantom{…} Create a phantom element with zero width and the same height 

B 

Fig.4.3 Phantom Elements 

In AxMath’s workspace, the phantom elements are displayed in a specific color (gray by 
default), as shown in Fig.4.4.A, and are completely hidden when output, as shown in Fig.4.4.B.  

 

Fig.4.4 A Phantom Example 

4.6 Spacing 

AxMath’s toolbox panel includes a number of buttons to create spacings, as shown in Fig.4.5, 
inside the red-edge rectangle. 

The relative unit em is typcially used for spaces in equation. One em equals to the width of 

the letter ‘M’. The button ( 
 
) is for creating a space of 1em, ( 

 

) for em, 

(  )
 
for em, and so on. Negative spacing (  ) is also supported. You can use the 

button (  )
 
to create a customizable spacing. You can modify an existing customizable 

spacing using the context menu, as shown in Fig.4.6. 

A B 
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If you need a lot of spacings to express something in AxMath, you are recommanded to turn 
on the option “show space in editor”, which can be found in the “Assistants” tab of the “AxMath 
Settings” dialog. 

 

Fig.4.5 Spacing 

 

Fig.4.6 Modify a x-Space using the Context menu 

4.7 Nesting of Expression-building Structures 

Expression-building structrues commonly have one or more sub-fields as nests for child 
elements. You can embed symbols, and other expression-building structures into a 
expression-building structure. There is no level restriction in such an embeding procedure. It arises 
as a technology to build special equations. See chapter 9, the tutorial, for more guides about that. 



AxMath Help                                                                                       2023-09-06 

Ver. 2.7.0.0 25 

 

5. Calculator 

5.1 How to Work 

AxMath’s calculator has most of the commonly used scientific calculating capabilities, such as 
arithmetic, exponential, logarithmic, trigonometric, permutations and so on. The calculator works 
exactly based on equation. It is a WYSIWYG and intuitive calculator and can be used to replace 
those desktop key-press-style scientfic calculators completely. 

When you have typed lines in the workspace like: 

, 

press the trigger key (equal sign ‘=’ by default), AxMath will calculate the value of  and fill 

the result at the end automatically, as shown below: 

 

The first line, of the above example, defines a variable named , and with a value of 32. The 

second line contains the constant  approximately equalling to 3.1415926 as known. The 

calculation result is the area of a circle with a diameter of 32, and it can be cited as another 

varibale, represented by the , in the following lines if you will. 

You can save such a procedure to a file, and re-open it when necessary, then change the value 
of the variables and run it all again by using the entry “Calculate All Lines” of the context menu, or 
the hotkey F6. If you have some calculation tasks that are repetitively used and with long 
procedure, AxMath will save you a lot of time. 

You can disable the calculation by the check button in the “Calculator” tab of the “AxMath 
Settings” dialog if you do not need it. 

5.2 Constants 

You can define constants in the “Calculator” tab of the “AxMath Settings” dialog. A legal 
constant must be a string started with a character and can not has sub/sup script or accents. 

5.3 Variables 

Unlike the constants, A legal variable of AxMath must be one character and can has sub/sup 
script or accents. For examples: 
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The variables are defined in the workspace. You can type more than one variable definition in 
one line and separate them from each other using commas. 

5.4 Units 

AxMath’s calculator knows no idea about physical units. The user must have the system of 
units in his mind when do a calculation using AxMath. 

When you define a varibale of angle, the default unit is rad. If you want define a angle using 
degree/minute/second, type the unit symbols after the numbers, like: 

 

Here the variable  has the same value with . 

5.5 Results 

Correspondingly, AxMath will display no unit after the calcluation results, but you can set the 
format of the results, i.e., integer or float, rad or degree, normal or percentage, using the context 
menu. You can also make the results to be background brushed with a special color to distinguish 
them from normal numbers. The options are in the “Calculator” tab of the “AxMath Settings” 
dialog. 

5.6 Explanations on Ambiguous Expressions 

1. AxMath only accept one kind of scientific noataion format, i.e. the natrual one such as 

. The linear format like , even commonly being used in other computer softwares, is 

not recognizable. 

2. Variable definitions are prior than constant definitions. 

3. A power exponent expression must be built using the superscript structure (  ). 

Expressions built by the dual-script structure ( 
 

) will be recognized as permutation, started 

with a uppercase P, or combination, started with a uppercase C. 

4. A function following by a superscript  will be recognized as the inverse function, for 

example: 

 

5. Any function in a AxMath equation can only accept one argument. If the argument is a 
defined variable, a defined constant or a string of numbers, the bracket can be omitted. If the 
argument is a piece of equation that should be parsed primarily, the breacket can not be omitted 



AxMath Help                                                                                       2023-09-06 

Ver. 2.7.0.0 27 

to avoid ambiguity. See the following example: 

  

6. By default, “ ” calculates the natural logarithm while “ ” calculates the logarithm based 

on 10; “ ” also calculates the logarithm based on 10 if it is not followed by a subscript field 

otherwise the logarithm base on the value of the subscript field. For examples: 
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6. Using AxMath with Applications and Websites 

6.1 Output Pictures 

The sub-menus for picture export are provided both in the main menu (  ) and the 

context menu. The supported formats include:  

1. Windows Bitmap (*.bmp)|*.bmp| 

2. Joint Photographic Experts Group (*.jpg)|*.jpg| 

3. Graphics Interchange Format (*.gif)|*.gif| 

4. Portable Network Graphic Format (*.png)|*.png| 

5. Tagged Image File Format (*.tiff)|*.tiff| 

6. Windows Enhanced Metafile (*.emf)|*.emf| 

Another way to get the picture of the equation in the workspace is using the clipboard. 
Right-click anywhere in the workspace and press “Capture Picture” in the context menu, then the 
clipboard will be set with the picture data. Metafile and bitmap are both available in that way, you 
can set the option in the “Advanced” tab of the “AxMath Settings” dialog. 

6.2 Working with LaTeX 

Please refer to section 3.5 and section 3.7 for detailed information about how to work with 
LaTeX. 

6.3 Working with Insert Object 

Object Linking and Embedding (OLE) is a technology that enables an application to create 
compound documents that contain information from a number of different sources. It is supported 
by many applications in Windows OS. They are called OLE containers in this sense and most of 
them have an insert object command entry in their “Insert” menu or somewhere else. The 
command opens a dialog containing a list of all types of objects that can be inserted. Then choose 
the item named “Equation.AxMath” and AxMath will open an new server instance. Edit your 
equation and close the window when you are done, the new equation will appear in the 
container’s document. Any time you want to edit the equation, just double-click it, or right-click on 
it to find the “Edit” or “Open” command in the context menu. 

You can also insert an AxMath object to an OLE container by using the Windows clipboard, as 
mentioned in section 3.7. 

The core of an AxMath object that existing in an OLE container’s document is a Windows 
metafile image. It is a type of vector image rather than a bitmap one. So you need not worry about 
the display quality in the final medium, printed sheets or a pdf file, although the objects are not 
displayed well on the screen in some cases.  

6.4 Add-in for Microsoft Word 

AxMath installer adds a couple of buttons, as shown in Fig.6.1, to Microsoft Word’s Ribbon 
(need Word 2010 or later) to help editing documents containing equations.  
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Fig. 6.1 The AxMath Add-in Category on MS WORD Ribbon 

 

6.4.1 Inserting AxMath Equations 

You can insert AxMath equations into Word documents by the clipboard or by the insert 
object menu, as described in previous sections. Yet you are recommended to use the add-in 
buttons to insert equations because they work properly with the set equation preferences 
commands that help ensure consistency between the equations in your documents. The AxMath’s 
add-in provides 5 commands for inserting AxMath equations.  

1. Inserting an inline equation 

This command inserts an AxMath equation to the Word document at the caret point. The 
equation is aligned with the surrounding text at the baseline. It is used to insert an equation in a 
sentence. 

2. Inserting a display equation 

This command inserts a new line firstly if the caret is not already at a new line, and then insert 
an AxMath equation at the center of the line. 

A Word style named AMDisplayEquation is defined to the Word document at the first time 
you add a display equation. This style inserts a center tab and a right tab in the line side with the 
equation and make the equation being centered by properly positioning the tabs. You can modify 
the style by “Format Numbers” – “Modify the Looking Style of Equation Numbers” from the 
add-in menus. 

3. Inserting a left-numbered display equation 

This command inserts a display equation firstly, as discribed in the previous paragraph. And 
then inserts a left-justified equation number at the line head. 

4. Inserting a right-numbered display equation 

This command works quitely similar to inserting a left-numbered equation but the quation 
number is right-justified and at the line tail. 

5. Toggle AxMath/TeX 

The Toggle AxMath/TeX command allows you to type/paste LaTeX code directly into a Word 
document and convert it into an AxMath equation, or conversely, return an AxMath equation to 
LaTeX. To distinguish from normal text, you should envelop the LaTeX code using LaTeX math 
equation delimiters. Using either the $...$ or \(...\) delimiters results in an inline equation after the 
command, and using either the $$...$$ or \[...\] delimiters results in a display equation after the 
command. To use the toggle with a single equation, click the TeX Toggle icon and the equation 
represented by LaTeX code nearest the caret will be converted to a AxMath equation. To convert 
the entire document or part of it, select the contents and click the submenu “From LaTeX to 
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AxMath”, or “From AxMath to LaTeX”. They are both below the icon “Convert Euqations” of the 
AxMath add-in menu. 

You can also insert an AxMath equation to a Microsoft Word document using hotkeys, as the 
following list: 

1. Inserting an inline equation(Ctrl+Shift+Q) 

2. Inserting a display equation(Alt+Q) 

3. Inserting a left-numbered display equation(Ctrl+Shift+Alt+Q) 

4. Inserting a right-numbered display equation(Shift+Alt+Q) 

5. TeX Toggle with a single equation(Alt+\) 

6. Open the equation object near the cursor(Alt+Enter) 

 

6.4.2 Numbering Equations 

The numbering commands allow you to insert equation numbers and references to the 
numbers in a Word document in a variety of formats. Both numbers and references are 
automatically updated whenever you add new equation numbers to the document or delete 
equation numbers from it.  

Equation numbers are independent from the equations in a Word document. The equation 
number is not automatically deleted when you delete a equation. Similarly, an equation reference 
is actually a reference to an equation number, rather than a reference to the equation itself. 

The format of equation numbers in a document is defined using the Format Equation 
Number dialog. An equation number is generally comprised of a chapter number, a section 
number, an equation number, a delimiter and one or more separators, as shown in Fig.6.2. The 
chapter number, section number, separator and delimiter are all optional, you can create either 
fully defined euqation numbers such as (1.1.1), [1.I.A], or simpified ones such as (1.1), 1.1, or even 
just 1 or a. 

When you edit a document, the sequence of some equation numbers or references may be 
changed. You can use the Update Numbers command in the AxMath add-in menu to update them 
to the sequence. If you select a region of your document, only this region will be updated, which 
can be useful with very large documents where entirely updating may take a relatively long time. 

When you insert a number to an existing display equation, you should add a tab between the 
number and the equation to make the number properly aligned to the page boundary.  

You can read E-12 in chapter-9 of this document to learn how to create a reference to a 
equation number in a WORD document. 
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Fig. 6.2 The Format Equation Numbers Dialog 

 

6.4.3 Chapter/Section Breaks 

If you are using the chapter numbers, you must insert a chapter break before the first number 
to define the chapter values. A break can have an explicit value or be set to increment by one the 
value of the preceding equation chapter. This is also complitant to the section numbers.  

Please note that the correct position for chapter/section breaks is the scratch point of the first 
normal papagraph of the chapter/section. Do not place them arround a heading title because the 
heading titles are usually related to the catalog of a Word document. Chapter/section breaks are 
built on field code, you can use the command “Show all breaks” to find them or edit them if 
necessary, and use “Hide all breaks” to hide them. All of the commands related to chapter/section 
beaks are below the icon “Chapters & Sections” of the AxMath add-in menu. 

Note: The chapters and sections referred to here are relative concepts. If you only use 2- 
level number format, the effect of using sections instead of chapters is the same. The 
chapter/section breaks inserted in the AxGlyph addin menu is independent of the structure of 
the WORD document body, and it works for the illustration number only. Also, don't put the 
chapter/section breaks in the title, which will cause the document directory to be confusing and 
should be placed somewhere in the body before the first illustration number. 

6.4.4 Browsing Objects Created by AxMath 

The AxMath browse commands allow you to search for equations, equation numbers and 
chapter/section breaks through a Word document. 

The chapter/section breaks are normally invisible. When browsing chapter/section breaks, the 
current chapter/section break will be visible in red. You can hide it using the method described in 
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the previous section. 

6.4.5 Format Equations 

When you insert a number of equations to a Word document, you typically want all of the 
equations to use the same font, style and colors so they look consistent throughout the whole 
document. Using AxMath scheme (see section 4.3) is a good way for that purpose. The add-in tab 
on Word Ribbon provides several commands to help format equtions in Word documents. 

1. Scale Reset 

Due to the user’s incorrect operation or some unknown reason. OLE pictures including 
AxMath equations may be strained or compressed unexpected in a Word document. This 
command is used to reset the aspect ratio of AxMath equations.  

2. Font Size 

Change the font size of all equations or equations in the currently select range. 

3. Using My Scheme 

Format all equations or equations in the currently select range using my favorite scheme. 
Please see section 4.3 for more details about scheme. 

4. Using Default Scheme 

Format all equations or equations in the currently select range using default scheme. Please 
see section 4.3 for more details about scheme. 

5. Toggle AutoColor 

AxMath equations can be automatically colored or manually colored (see section 4.2). You can 
use this command to toggle autocolor for all equations or equations in the currently select range. 

6. Detailed 

Format all equations or equations in the currently select range using the “AxMath Settings” 
dialog. 

7. Redraw Equations 

Re-render all equations or equations in the currently select range. 

6.4.6 Converting Equations 

The Convert Equations commands allow you to convert equations in a Word document from 
or to LaTeX code. The typical usage of these commands has been described in section 6.4.1.  

6.4.7 Auto Font Size 

Auto Font Size is not a command from the add-in. It is a option that allow AxMath to detect 
the font size of the surrounding text where you will insert a equation and make the new equation 
has the same font size with the surround text. You can find the option in “Advanced” page of the 
“AxMath settings” dialog. 
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7. Register & Upgrade 

The shared version of the software provides all core functions and basic editing tools. You can 
use it free of charge without time limit but its functionality is limited in some way. The licensed 
version is a better solution if you want to work efficiently with equations. The following list shows 
the functions that are only available in the licensed version. 

1. Cut, Copy, Paste 

2. Drag-Drop 

3. Gadgets on the Right Sidebar 

4. Find and Replace 

5. Recalculate All Lines 

6. Constants for Calculation 

7. Exporting Pictures with PNG, JPG, GIF, TIFF and EMF format. 

To use a licensed copy of AxMath on a specific computer, you must firstly activate your copy 
on the machine using a key. The key will be binded to the computer and can be used once again to 
activate the same computer but can not be used to activate another computer.  

We do not provide online incremental upgrading, but you will be notified if there are new 
releases. You need to download the latest installation package and do a reinstallation to upgrade 
the software. Please visit our website www.axsoft.co for detailed upgrade information.  

 

 

 

http://www.axsoft.co/
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8. FAQ 

Q-01. Why does the antivirus software alarm when installing AxMath 

The first version of AxMath was released at the end of 2014, and the antivirus software may 
be sensitive to a new software. The installation package downloaded from our official website 
(http://www.axsoft.co) is guaranteed being safe. To ensure security, you can use antivirus software 
to scan the installation package before installing.  

The installation and running of AxMath requires to read and write the system’s registry, if the 
antivirus software alarm for that reason, please select “allow all operations” or a option like that. 

Q-02. Equations appear as { EMBED Equation.AxMath } in a Word document 

This is related to a display setting of the MS Word. To display equations normally, do the 
following steps: 

1. Click the “File” tab, click “Options”. 

2. Select the “Advanced” catalog page in the navigation pane on the left.  

3. Find the option “Show field codes instead of their value” in the “Show document content” 
group and turn it off.  

You can also use the hotkey Alt + F9 to do the operation directly. 

Q-03. Equations appear as empty or shaded boxes in a Word document 

The “empty boxes” is a feature of MS Word called “Show picture placeholders” designed to 
save memory of the computer. This option helps minimize the amount of computer resources 
required to display a page and helps Word scroll multiple pages faster on-screen. Double-clicking 
these boxes will launch AxMath and display the equation, and the equations will print correctly. 
You can turn off the option so that the equations in your document display on the computer 
screen normally, as the following steps: 

1. Click the “File” tab, click “Options”. 

2. Select the “Advanced” catalog page in the navigation pane on the left.  

3. Find the option “Show picture placeholders” in the “Show document content” group and 
turn it off.  

The “shaded boxes” is another feature of MS Word called “Field shading” designed to make it 
easier to find OLE objects, such as AxMath equations. Please do the following steps to turn it off: 

1. Click the “File” tab, click “Options”. 

2. Select the “Advanced” catalog page in the navigation pane on the left.  

3. Find the combo list that labeled “Filed shading” in the “Show document content” group 
and select either “Never” or “When selected” in the list. 

Q-04. AxMath has been installed, but the add-in tab is not found or does not work 

The first possible reason is that the Office’s version is too old. AxMath’s add-in is only for 

http://www.axsoft.co/
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Office 2010 and later.  

The second possible reason is that when you install AxMath, there are some running Word 
processes in the system, in which case an write failure error will be prompted during the 
installation. To solve this problem, you should re-install AxMath and make sure that all Word 
processes have been quit before the re-installation. 

The third case is that when you insert a new equation using the addin command, An error 
message with code 4198 pops up, or a message box pops up prompting: “The program used to 
create this object is Equation. That program is either not installed on your computer or it is not 
responding. To edit this object, install Equation or ensure that any dialog boxes in Equation are 
closed.” Please try the following steps to solve this problem: 

1. Click the “File” tab, click “Options”. 

2. Select the “Add-Ins” catalog page in the navigation pane on the left.  

3. At the bottom of the page, find a combo list at the rightside of the label “Manage” and 
select “Disabled Items” in the list, then click on the button “Go” to open the “Disabled 
Items” dialog.  

4. Select “AxMath.dotm” in this dialog and click the button “Enable”. 

Try the following steps if the problem is still exist: 

1. Click the “File” tab, click “Options”. 

2. Select the “Add-Ins” catalog page in the navigation pane on the left.  

3. At the bottom of the page, find a combo list at the rightside of the label “Manage” and 
select “Templates” in the list, then click on the button “Go” to open the “Templates” 
dialog.  

4. Check “AxMath.dotm” in list. 

If AxMath add-in has been enabled but the problem still exists please try the following steps: 

1. Click the “File” tab, click “Options”. 

2. Select the “Trust Center” catalog page in the navigation pane on the left. 

3. Click on the button “Trust Center Settings” to open the “Trust Center” dialog box. 

4. Select the “Macro Settings” catalog page.  

5. Select “Disable all macros except digitally signed macros” or “Enable all macros”. 

In another case this problem is accompanied by a message box prompting: “’VBE6EXT.OLB’ 
could not be loaded”. VBE6EXT.OLB is Visual Basic Extensibility. It could be possible that 
VBE6EXT.OLB which is required to run VBA for Office is corrupted. See if you can repair the 
installation. If it doesn’t, reinstalling it should fix the problem. A reference solution can be found at 
https://social.technet.microsoft.com/Forums/office/en-US/1d3e9aa0-2069-4f7b-b6cf-c47e00d637
f5/vbe6extolb-could-not-be-loaded?forum=officeitproprevious 

Q-05. How to remove the AxMath’s add-in temporarily from MS-Word  

Open the Word Options dialog, and then click Add-ins. In the Manage combo list, select 
Templates, and then click Go. Uncheck the box next to the AxMath.dotm item.  

https://social.technet.microsoft.com/Forums/office/en-US/1d3e9aa0-2069-4f7b-b6cf-c47e00d637f5/vbe6extolb-could-not-be-loaded?forum=officeitproprevious
https://social.technet.microsoft.com/Forums/office/en-US/1d3e9aa0-2069-4f7b-b6cf-c47e00d637f5/vbe6extolb-could-not-be-loaded?forum=officeitproprevious
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Q-06. How to remove the AxMath’s add-in permanently from MS-Word  

Quit all Word processes and remove the AxMath Commands for Word file from Word's 
startup folder. You can seach the file named “AxMath.dotm” on your computer if you do not know 
where it is. 

Q-07. Why the add-in’s dialog box does not respond or contains warning content 

AxMath applies HTML dialogs in the WORD addins. The dialogs will not respond if the IE 
disables active scripting. Please try the following steps to fix the problem: 

1. Open IE, find “Tool” in the menu, the click the “Internet Options”. 

2. Select the “Security” catalog page. 

3. Click on the button “Custom Level…” to open the “Security Settings” dialog. 

4. Enable “Active Script”. 

In another case, a warning content is popped up: “To help protect your security Internet 
Explorer has blocked this website from displaying content with security certificate errors. Click here 
for options…”. This warning appears if the IE’s security level is set to the highest level. You should 
make sure that the IE’s security level is medium high or lower. You can search for more suggestions 
on https://answers.microsoft.com. 

Q-08. AxMath equations cause line spacing to increase in MS Word 

When an AxMath equation is inserted, sometimes it casuses the line spacing above and below 
the equation to increase. This makes the paragraph that contains the equation look less 
harmonious compared to rest of the document.  

The first solution for this problem is setting the paragraph line spacing to “Exactly”, and 
increase the line spacing to a suffient value to prevent the equations from being clipped off. You 
are recommended to read Q-09 of this chapter to learn more about “clipped off” and how to set 
the paragraph line spacing. 

The second solution does not need to set the line spacing to “Exactly”, but it is only a 
approximate solution rather than making all lines equidistant. The solution is implemented by the 
following steps: 

1. Click the “Page Layout” tab from the MS Word’s Ribbon. 

2. Go to “Page Setup” group and click the “Page Setup” button (the small arrow at the right 
bottom corner) to open the page setup dialog. 

3. Select the tab “Document Grid”, selete “No Grid” in the “Grid” group. 

4. Make sure that the font size of the equations is not larger than the surrounding text. 

Q-09. Top and bottom of AxMath equations are clipped off in MS Word 

If the paragraph line spacing in MS Word is set to “Exactly” and the line spacing value is not 
big enough, when you insert AxMath equations into a Word document, the top and bottom of 
some of the equations may be clipped off. 

To solove this problem, you can either select an option other than “Exactly” in the line spacing 
combo list, or increase the line spacing to a suffient value if you still want to use “Exactly” line 

https://answers.microsoft.com/
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spacing. You can find all these setting items by the following steps: 

1. Click the “Home” tab from the MS Word’s Ribbon. 

2. Go to “Paragraph” group and click the “Paragraph” button (the small arrow at the right 
bottom corner) to open the paragraph setting dialog. 

3. Select the tab “Indents and Spacing”, you will find a combo list labeled “Line Spacing” and 
a edit box labeled “At”, which is for inputing the line spacing value. 

You are recommended to read Q-08 of this chapter to learn how to properly set the line 
spacing of the paragraphs that contain AxMath equations. 

Q-10. AxMath equations appear raised above the baseline in MS Word 

In most cases, you just need to redraw or rebuild the equations to solve the raise issue. There 
are three methods we recommend to redraw: 

1. Select the equation and right-click in MS Word to pop up the context menu, then select 
AxMath Object>>Redraw from the context menu. 

2. Double-click the equation to open it in AxMath. Click on the button “Save” (  ) or 

press the hotkey Ctrl+S to save it. Close AxMath and back to Word. 

3. To re-draw all equations in the whole document or in a select range, click on the icon 

( 
 
) from AxMath’s addin on MS Word’s Ribbon. 

If the redrawing method does not work, try to rebuild the equations by following the steps 
below: 

1. Involve the equations with the raise issue into a selection range 

2. Click on the icon (  ) from AxMath’s addin on MS Word’s Ribbon.  

There is a very specific case caused by a Microsoft security update. It is a bug of MS Word so 
Microsoft should fix it. This bug mainly have effect on .docx document of MS Word. So, a method 
to prevent the problem from occurring is to save your file as a .doc format, rather than .docx.  

Until Microsoft gives a reliable solution, you will need to make some adjustment to the 
“Position” attribute inside the “Character Spacing” properties. Please follow the steps below: 

1. Move the caret right after the equation that raised vertically in the line. 

2. Select the “Home” tab from the MS-Word’s Ribbon. 

3. Go to the “Font” group and click the “Show Font Dialog” button (the small arrow at the 
right bottom corner) or press the hotkey Ctrl+D to open the font dialog. 

4. Select the “Character Spacing” tab in the font dialog. 

5. Click the combo list labeled “Position” and select “Normal” from the list. 

6. Click OK on the Font dialog. 

7. Re-render the equation if necessary. 

Q-11. Equations in a Word document are deformed 

When you re-open a Word document that contains AxMath euqations, you may find some of 
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the equations have been deformed, i.e. stretched or squashed. This bug has existed for a long time 
in MS-Word.   

Until Microsoft solves it completely, you can use the command “AxMath Scale Reset” (  ) 

on the add-in to restore all AxMath equations to their original scale. Please see section 6.4.5 for 
more information. 

Q-12. How to change the style (font) of equation numbers 

In MS Word, the equation numbers are styled with a style named AMDisplayEquation (see 
section 6.4.1). You can modify the style by “Format Numbers” – “Modify the Looking Style of 
Equation Numbers” from the add-in menus. 

Q-13. Equations and equation numbers are out of position 

This problem usually occurs after page layout or page margins are adjusted. You sometimes 
notice after such a adjustment, the display equations are no longer centered properly, or the 
equation numbers are no longer closely aligned at the right page boundary. 

In MS Word, AxMath equations and the numbers are both positioned with a style named 
AMDisplayEquation (see section 6.4.1). Therefore, making any change that affects margin settings 
may cause this problem. The AMDisplayEquation style was inserted at the first time you added a 
display equation. It is not listed in the Style Gallery of MS Word by default. Please read Q-12 of this 
chapter to learn how to find the style and modify it. 

You can also do an autocorrect using the command “Update Numbers” (  ) from 

AxMath’s addin on MS Word’s Ribbon. 

Q-14. In some applications the equations shows blurring 

This is because AxMath has compatibility issues with the application. You can try to solve the 
problem by updating the software to the latest version. 

Q-15. Can not select a specific segment while editting a equation using the mouse 

You can press down the left button of your mouse and move the mouse cursor from one point 
to another, to select a specific segment from the workspace. That is a very commonly used 
operation in most of text editor.  

In most cases when editting a equation in AxMath, you can precisely select what you want to 
select by controling the start point (where you press down the left button) and the end point 
(where you release the left button). But for expression-building structures that have one or more 
child fields, sometimes it is difficult to do such a selection because the parent’s boundary coincides 
with, or is very close to, one of its children. In these cases, you can use the keyboard to make the 
selection. For example, if you want to select the numerator from a fraction, rather than the whole 
fraction, you can follow the steps below: 

1. Move the caret to the head of the numerator. 

2. Press the Ctrl key down and hold it before you finish the selection. 

3. Knock the right arrow key for some times until the numerator is completely selected. 



AxMath Help                                                                                       2023-09-06 

Ver. 2.7.0.0 39 

Q-16. The icons on AxMath’s UI are too small to identify 

This issue is serious on those computers with a high resolution screen. The solution is: 

1. Right click on the toolbox panel, select “Appearance…” from the context menu to open the 
appearance settings dialog.  

2. Select “Large” or “Auto” from the combo list titled “Toolbar Size”.  

3. Restart AxMath. 

Q-17. The chapter/section breaks leads to a disordered catalog 

This issue arises if one or more chapter/section breaks has been placed together with the 
chapter/section title. The chapter/section breaks should be placed at the head of the body text 
rather than the title. 

Q-18. The “Insert AxMath Equation” on PowerPoint’s Ribbon does not work 

This issue arises if the template file name “AMObj.afx”, which is located in a subfolder named 
“User” from AxMath’s installation path, was setted with a “Read only” file attribute. Remove that 
attribute from the file to fix this problem. 

Q-19. Some menus, buttons or controls of AxMath do not work in Win10 

If you have upgraded your OS from Win7 or Win8 to Win10, there is a possibility of such a 
problem. Win10 is far away from a stable system. 

You can try reinstalling AxMath to solve the problem. If it is still exist after that, follow the 
steps below: 

1. Right-click on the icon of AxMath and select Properties in the context menu. You can do 
this from the AxMath's shortcut or by navigating in File Browser to the exe file.  

2. Select the Compatibility tab, then check the box next to “Run this program in compatibility 
mode for ”. 

3. Select the version of Windows to use for your app's settings in the dropdown box, Win7 or 
Win 8. 

4. Hit Apply, then run your AxMath and see if this fixed your issues. 

Q-20. Euqations have become non-editable “picutures” in MS-WORD 

When opening a previously saved MS-WORD document containing AxMath objects, you may 
find that all or some of AxMath objects have become no longer editable. This issue is associated 
with the Auto-recovery function in MS-WORD, i.e. it is a bug of MS-WORD. The same issue 
happens with not only AxMath, but also any kind of OLE object, including MS-EXCEL charts. 

Microsoft recommends turning off the Auto-save function, especially when editing a large 
volume document. Unfortunetly, Microsoft has not provided any way to repair those OLE objects 
that have already become non-editable.  

Follow the steps below to disable the Auto-save fucntion in MS-WORD: 

1. Click the “File” tab, click “Options”. 
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2. Select the “Save” catalog page in the navigation pane on the left.  

3. Remove the check mark from "Save Auto-recovery data every x minutes.” 
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9. Tutorials 

In this chapter, A series of tutorials are presented to help you become more skillful at 
euqation editting using AxMath. We have tried to cover as many subjects as possible in the 
turorials, also contains some relatively uncommon or more complex equation examples. 

If you have no experience in using AxMath, we recommend you read and exercise all tutorials 
step by step from the very scratch. Some steps may only have a simplified description if a similar 
step has been described in detail in a previous example. 

The following step-by-step instructions for each example are based on the symbol panel of 
AxMath. When you are familiar with the use of this software, we recommand you use the hotkeys 
and the interactive LaTeX as far as possible to improve the working effciency. 

Since AxMath is not a linear editor, you will need to move the caret from one field to another 
frequently. In most cases, you can move the caret to the desired field using the four arrow keys 
according to the relative position. 

E-01. A Basic Tutorial of Fraction, Sub/Sup Script and Square Root 

In this tutorial we will create the equation 

  

1. In the AxMath workspace, type . 

2. Click on the icon (  ) from the palette (  ), or press the hotkey Ctrl+L, to 

create a subscript after the , then type  in the subscript field. 

3. Press the right arrow key to move the caret out of the subscript field and type . 

4. Click on the icon (  ) from the palette (  ), or press the hotkey Ctrl+F, to 

create a fraction after the . 

5. Type  in the numerator field of the fraction. 

6. Click on the icon (  ) from the palette (  ) to create a  after the . 

7. Click on the icon (  ) from the palette (  ), or press the hotkey Ctrl+R, to 

create a square root after the . 

8. Type  inside the radical. Click on the icon (  ) from the palette (  ), or 

press the hotkey Ctrl+H, to create a supscript field after the . Type  in the supscript 

field and press the right arrow key to move the caret out of the supscript field. Make sure 
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that the caret is still inside the radical, then type . 

9. Press the down arrow key to move the caret into the denominator field of the fraction. 

Then type , you can also move the caret by mouse clicking on the denominator 

position. 

E-02. A Basic Tutorial of Greek Characters, Sum, Bracket and Accent 

In this tutorial we will create the equation 

  

1. In the AxMath workspace, click on the icon (  ) from the palette (  ), or 

press the hotkey Ctrl+G and type “s”, to create a Greek character . 

2. Click on the icon (  ) on the pallete (  ), or press the hotkey Ctrl+H, to 

create a subscript after the , then type  in the subscript field. 

3. Press the right arrow key to move the caret out of the subscript field and type . 

4. Click on the icon (  ) on the pallete (  ), or press the hotkey Ctrl+F, to 

create a fraction after the . Then type  in the numerator field and  in the 

denominator filed respectively. 

5. Move the caret out of the fraction by pressing the right arrow key. Then click on the icon 

(  ) on the pallete (  ) to create a sum with three sub-fields. 

6. Type  in the top sub-field of the sum and  in the bottom sub-field. 

7. Press the right arrow key to move the caret into the right sub-field of the sum. Click on the 

icon (  ) on the pallete (  ), or press Shift+9, to create a bracket. 

8. Create  into the brecket. Make sure the caret is at the right side of the second  

then click on the icon (  ) on the pallete (  ), this operation will change the 

second  into . 

9. Press the right arrow key to move the caret out of the bracket. Click on the icon (  ) 

on the pallete (  ), or press the hotkey Ctrl+H, to create a supscript after the 

bracket. Type  in the supscript field. 

E-03. A Basic Tutorial of Multi-line Equation 

In this tutorial we will create the equation 
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There are two methods to create this equation. If you need to convert the equation to LaTeX 
code, then use the first method, otherwise, the second one is recommended. 

Method-1: 

1. In the AxMath workspace, type . 

2. Click on the icon (  ) from the palette (  ) to create a left aligned array with 

2 elements. 

3. Move the caret into the top element and create . 

4. Then create  into the bottom one. 

Method-2: 

1. In the AxMath workspace, type . 

2. Press Enter key to create a new line. 

3. Then create  into the second line. 

4. Make sure the alignment is set to “Align at ‘=’” (  ) before saving and 

exiting. 

E-04. A Basic Tutorial of Piecewise Function 

In this tutorial we will create the equation 

  

1. In the AxMath workspace, click the icon (  ) from the palette (  ) to a 

couple of absolute delimiters, the type  into the sub field. 

1. Move the caret to the end of the line and type . 

2. Click on the icon (  ) from the palette (  ) to create a piecewise function 

template, which provides 4 sub fields. 

3. Fill the sub fields of the template respectively. 

4. You can press the Enter key at the end of the last sub field to create a new row if you need 
one more domain. 
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E-05. Modify Matrix Elements in Batch by Finding and Replacing 

In this tutorial we’ll modify the matrix from  to . 

Obviously, deleting and typing one by one is a effective but low efficiency approach. For this 
case, you can using finding and replacing to modify the matrix more efficiently. 

1. Select any a  from the matrix. 

2. Right click in the workspace, and click the command “Find the Similar Segments” in the 

context menu, or press the hotkey F3. Then you will find all of  are background brushed 

with light-green color. 

3. Move the caret to the tail and create a template , then select it. 

4. Right click in the workspace, and click the command “Replace All Find Results With The 
Selected” int the context menu. 

5. Delete the template . 

E-06. An Advanced Tutorial of Matrix Nesting, Spacing and Arrows 

In this tutorial we will create the equation 

  

1. In the AxMath workspace, click on the icon (  ) from the palette (  ) to 

open the matrix layout dialog. Set rows to 9 and close the dialog. 

2. Move the caret to the first element and type .  

3. Move the caret to the second element, then click on the icon (  ) on the pallete 

(  ) to create a down arrow into the sub-field. 

4. Move to the third element, and fill  into the sub-field. The 

characters with mathcal font style can be found on the pallete (  ) and the 

arrows with a top sub field can be found on the pallete(  ).  
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5. Fill the remaining rows similarly. You need click on the icon (  ) on the pallete 

(  ) after the down arrow to create . 

6. Move the caret to the head of the first row. Click on the icon (  ) on the pallete 

(  ) to create a customizable spacing and give it a proper width. Please see 

section 4.6 to learn more about spacing and how to adjust the width of a customizable 
spacing. 

7. Insert spacings to anywhere you think it is needed, and adjust their width until the 
equation is correctly expressed and looks coordinated.  

E-07. An Advanced Tutorial of Phantom and Negative Spacing 

In this tutorial we will create the equation 

  

1. In the AxMath workspace, click on the icon (  ) from the palette (  ) to 

create a overbrace structure with 2 sub-fields. 

2. Move the caret to the top sub-field of the overbrace, then type  into the field. 

3. Move the caret to the bottom sub-field of the overbrace, then click on the icon (  ) 

on the pallete (  ) for seven times to create seven circles into the sub-field. 

4. Select the last three circles in the bottom sub field of the overbrace, then click on the icon 

(  ) from the palette (  ) to create an child overbrace structure with 2 

sub-fields. 

5. Move the caret to the top sub-field of the child overbrace, then type  into the field. 

6. Move the caret to the end of the line, then click on the icon (  ) from the palette 

(  ) to create an underbrace structure with 2 sub-fields. 

7. Move the caret to the top sub field of the underbrace structure and create five circles, as 

described in step 3. Then type  into the bottom sub field. 

8. Select the left three circles in the top sub field of the underbrace, then click on the icon 

(  ) from the palette (  ) to change the selection to be a phantom 

element. 

9. Insert a customizable spacing before the underbrace structure and adjust its width until 
the equation is correctly expressed and looks coordinated. 
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E-08. An Advanced Tutorial of Atom Electron Shell Diagram 

In this tutorial we will create the atom electron shell diagram 

  

1. In the AxMath workspace, click on the icon (  ) from the palette (  ) to 

create the nucleus, and type  into the center field. 

2. Move the caret to the end of the line, click on the icon (  ) from the palette 

(  ) to create the first electron shell, and type  into the filed. 

3. Repeat step 2 twice to create the second and the third electron shell. 

E-09. An Advanced Tutorial of Compound Structure 

In this tutorial we will create the compound structure 

  

1. Type  into the AxMath workspace. 

2. Click on the icon (  ) from the palette (  ) to create a strikethrough 

structure as the the first single bond, then insert a “1M” (  ) spacing into the 

strikethrough structure. The spacing is used to give the bond a proper length. 

3. Move the caret to the end of the line, then click on the icon (  ) from the palette 

(  ) to create a bottom aligned array with 2 sub-fields. 

4. Type  into the bottom sub field and create another bottom aligned array (  ) 

into the top field. Then create the  and the  at proper position. The  can be 

found on the pallete (  ). 

5. Creat the centered  and the right half similarly. 
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E-10. An Advanced Tutorial of Electronic Formula 

In this tutorial we will create the electronic formula 

  

1. Type  into the AxMath workspace. 

2. Move the caret to the end of the line, then click on the icon (  ) from the palette 

(  ) to create a top aligned array with 2 sub-fields. 

3. Move the caret to the top sub field of the array, then click on the icon (  ) from 

the palette (  ) to create a electronic formula template and open the electronic 

formula designer dialog. You can click the positions to switch between solid dots and 
crosses.  

4. Type  into the centered sub field of the electronic formula template. 

5. Type  into the bottom sub field of the array. 

6. Move the caret to the end of the line and type the last . 

7. Select all and click the icon (  ) from the palette (  ) to create a center 

alignment structure. Such a operation will move all what you have created in the previous 
steps to the sub field of the center alignment structure. 

8. Select all once again and click the icon (  ) from the palette (  ) to a 

couple of square brackets. 

9. Move the caret out of the brackets, then create the supscript  at the end of the line. 

E-11. An Advanced Tutorial of Reaction Equation 

In this tutorial we will create the reaction equation 

  

1. In the AxMath workspace, click on the icon (  ) from the palette (  ) to 

create a over-under structure with 3 sub-fields. 

2. Move the caret to the middle sub field of the over-under structure, then create 
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 into the sub-field. Use the icon (  ) 

from the palette (  ) and the icon (  ) on the pallete (  ) to 

create the long equal sign with a heating symbole . Use the icon (  ) from the 

palette (  ) to create those atoms with a top label of charge number. 

3. Move the caret to the top sub field of the over-under structure, then click on the icon 

(  ) from the palette (  ) to create a over-script structure with 2 

sub-fields. 

4. Move the caret to the bottom sub field of the over-script structure, then click on the icon 

(  ) from the palette (  ) to create a left to right transition symbol.  

5. Type  into the top sub field of the over-script structure. 

6. Create a customizable spacing before the over-script structure and give it a proper width. 

7. Create a customizable spacing into the sub field of the transition symbol and give it a 
proper width. 

8. Fill the bottom sub field of the over-under structure similarly. 

E-12. Insert number references in a Word document 

1. In MS Word, move the caret to where you want insert the reference. 

2. Click on the icon ( 

 

) from AxMath’s addin on MS Word’s Ribbon, a placeholder 

in yellow backgroud (*) will appear. 

3. Click the equation number that you want to refer to, the placeholder will be replaced by 
the number. 
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